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ASCENDER - Position Management: Update
NYR Positions and Move Employees to CYR
Payroll

This guide provides the necessary steps to update next year positions and move 12-, 11-, and
10-month employees to the current year payroll.

This guide assumes you are familiar with the basic features of the ASCENDER Business system
and have reviewed the ASCENDER Business Overview guide.

12-month Employees

11-month Employees

This process moves employees who receive their first paycheck in August from next year Position
Management to current year Position Management. It also updates some of the fields on the
following Payroll >Maintenance > Staff Job/Pay Data and Personnel > Maintenance >
Employment Info tabs in the current year payroll (see step 16 for detailed information):

e Employment Info
e Pay Info

e Job Info

e Distributions

A separate simulation will be set up for 10-month employees at a later date. This is necessary
because the position in the next year PMIS reflects the current year salary information. The
simulation updates the fields in the next year positions for the new school year and clears the
Accept Changes field. The new salary information from the next year position is updated in the
current year, updating both the current year PMIS and the Staff Job/Pay Data fields for the
employees. If 11-month employees accrue, it is important to move them to the next year payroll
in order to perform the accrual process.

Note: Depending on the LEA, it may not be necessary to set up separate simulations. If the LEA
has determined next year salaries and completed all interfacing to Budget for the year, one
simulation can be used when moving employees. Contact your regional ESC consultant to discuss
this option.

It is important to consider how this process affects the budget. If you update 11-month positions
with the new salary amount for the next school year in the next year PMIS, running the simulation
a second time at a later date for all employees gives the 11-month employees an additional
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increase. If you were unable to update Budget with accurate salaries for all employees prior to
moving the 12-month employees, it is necessary to update Budget with multiple simulations.
Reference the Interface to Budget Checklist located at the end of this document.

The following checklist assumes that the LEA has interfaced the payroll salaries to Budget using
the PMIS Salary Simulation process.

1. Verify account code fiscal years.

Position Management > Utilities > Update Fiscal Year by Fund

Verify that the account code fiscal years are accurate. This tab provides a list of the fund/fiscal
years that are set up in the positions. This process increments the position distribution fiscal
year by 1.

Note: Since the account codes are validated against the budget, there should not be any
fiscal years less than the next year. If there are, generate a user-created report to identify
the positions and manually update the information.

2. Generate a user-created report.

Position Management > Reports > User Created Reports > CYR/NYR Positions

Generate a PMIS User Created Report to verify that the Increase Eligible field is selected for
applicable positions. It is possible that the field is not selected for new LEA employees from last
year.

TIP: For 10- and 11-month employees, it is recommended to verify the Nbr
& Remain Payments field prior to calculating salaries.

O Select the following fields on the user-created report:

o First Name

Last Name

Position Nbr

Billet Nbr

Position Type
Increase Elig

Nbr Remain Payments

[¢]

o

[¢]

[¢]

[¢]

[¢]

2026/01/28 17:20 2 ASCENDER - Position Management: Update NYR Positions and Move Employees to CYR Payroll


https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/updatefiscalyearbyfund
https://help.ascendertx.com/test/business/doku.php/positionmanagement/reports/usercreatedreports/cyrnyrpositions

Business

| [ comererr ) [ oeme [ e )

Report Title

PMIS Position/Distribution Export File Auto Select Options

D PMIS Position Conitrol D PMIS Position Distribution

DF’MIS Position Control

[]CYRMYR Flag
Position Mbr
Billet Nbr
Position Type

[Jcentract Beg Date
D Contract End Date
D Payoff Date
[Orior Days off

[ et Hrly Dly Rate

n Status [T]5alary Amount

[Jpay Empld Pet

UP:‘. of Year

[JExtra Duty Code [Oinactiv
D Supplement Type D"Jac =
DS_pplerne'.t Max Amt DPEV Grade
DBase Suppl On Dly Rate DPE; Step
[J5ueplement Fay 1 Time [JPay Schedule
DDEtE Supplement 1 Time DFI'E - Equi its
Dh::eot Change D‘Jicp:.:n:E ]
D Date Create/Update DPercent of Midpeint

[j Drate Fill Dunemolc-.-me.'.t Elig Flag
[JFit Pesition Reason [OJrica elg

D Date Criteria DTHS Status Code

D Date Authorization DBng et Amount

[:] Date Authorization End DBch_: et Salary Override
D Date Entry Dh::-al-'EI-_-ﬂge'_ lmd

D Date Inactive DPE\- Type

D Occ Pay Type

D Suppl Recaloulate
[Jign Pet Day For Sal Cales
[Jign Pet r For Sal Cales
D Mew Employes

Position Description

DTRS Position Code
[:] Position School Year I Mbr Remain Paymeants I DMaA Diays
DFI’E:J'_EHC\' |_JJob Categary DMaA Payments
Dcu: Employes Nbe D Supplement Attached Dl;l-.-'_'r Elig Flg

[ ]Primary Job DDL‘- Code DSta'Je Mimimum Days
D'_st Pay Date Code [:]Snus' Position Nbr

|| O Pay Grade [:| Calendar Code [:]Sa vsr Billet Mbr
[:]G.;: Pay Step D Campus ID DSupaieme nit Extra Days
DG.;: Pay Schedulse D Dept [:|Su|:-m to Pos Mbr
DSta:e Step Dl—irs Par Day DSJP:J:. to Pos Billet

DF’MIS Position Distribution

JCyRMvR Flag
[OPosition Mer

Job Code Function Ed Span
0 O (Jed S

Expense 373
Da‘\.cr.su'.t Type D Object D Project Detail D =

DCO:T_’”:- Acct Flag

[Oeittet Mbr

[rasitian Type

[ pistribution Sequence

DFr;—.‘a_anT

Dl"ay Auctivity
[Jworkers' Comp
[CJFite 1D

DFu"nc

[ sub Object

[ organization
[JFiscal Year

D Program Intent

D;"u::c: unt Amount
[JAccount Percent
[JTRS Grant Code
D Extra Duty Code

D Employes Demao

First Name

[:|M-:|c:lsNa1~-_'- D-Ge.'.era:ic’.

O Click Create Report. The requested report is displayed. Use the sort/filter functionality to
group the applicable data.

Note: Only positions with the Increase Elig field set to Y will receive a salary increase. The
number of remaining payments reflected on this report is the number of annual payments
and the number of remaining payments for the employee on the Payroll > Maintenance >
Staff Job/Pay Data > Job Info tab. Perform any position corrections prior to continuing the
process.

3. ldentify the employees to be moved to the current year payroll.

Log on to the current year.
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Payroll > Reports > User Created Reports

Generate a user-created report to identify the employees who begin their new contract in
August. It is possible that the employees are inactive in the current year, be sure that the
Active Employees Only field is not selected.

[ e ) (cmeromn ) [ oo J[ e ] - et

Employee \lbr{:]g [JActive Employees Only

D Employes Demographic

[F)Emplayes Nbr

u
[Ostreet/P.0. Box
| Oaet

DC ity
I DS'.ate

Ozie

Ozip+4

D Addr Country

8.
ZI %
E.
a =
(Jooe

chb Information

gooooog

[Jvrs of Job Exper

[Opistribution
Db cd [OExtra Duty Cd [Oworkers' Comp Oray Acty OAcet Amt Oacet Pet [OTRS Grant Cd OExpens= 273
DFu nd Dl'Jojec( DSuo Object Dl'Jrga nization DF scal Year DI”ro; ram Intent DE.:: Span DFro.ec( Detail

[Jcontrib AcctFlg ] Perf Pay

DDec uctions

DDec;c:ic n Cd D Employee Amt DE”;.-;--.-&' Amt D Remain Pymts D Refund DCa"e 125 D Emplr Contrib Factor DTE;“- Contribs Factor

O Prepare a list of new hires as a supplement to this list. Sort by the Payoff Date to verify that
all employees with a July payoff date have the same date. For example, it is possible that an
employee has a payoff date that is a day before or after the actual July payoff date.

O Use the current year payroll Payroll > Maintenance > Staff Job/Pay Data > Job Info tab to
make corrections as needed.

O Generate a user-created report again to verify that all of the data is accurate. Filter the report
using the LEA's July payoff date (YYYYMMDD).
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SortFilter

[ v [] Sort Criteria l
| - Filter Criteria |

[ Add Criterion ] | Delete Selected

D Column Operator Value Logical

] Fayoff Dat= W = [20220725 |

[ oK /| Cance

Print or save the report for verification purposes.

4. Create a salary simulation.

Log on to the next year.

Prior to setting up and performing salary simulations, review the Position Management:
Salary Simulations Overview document for a description of the Salary Simulation pages and
samples of the available simulation reports.

Position Management > Utilities > Salary Simulation > Simulation Options
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Simulation Name[:] = Simulation Desuiptinn{ ] .
SIMULATION OPTIONS FIRST PAY DATE CODES FUND/AISCAL YEAR EXCLUSIONS LOCAL ANNUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDATE
If updating tables, please create export for Budget Tables
] ’ Add Simulation l [ te ] [ Delate l prior to using this wtility.
Simulation Name: :] Simulation Description: [ User ID:
Calculation Options Update Options
Include Proposed Positions: Update far Active Positions [E. - Move Actual Amount to Budget Amount v]

Onily

( Include Wacant Supplement Positions:

Forecast

Incremant Pay Staps
Maximum Annual Pay Step:

Maximum Hourly/Daily Pay Step:

Budget

[‘l - Do not update Budget

-

—

Budget Amount:

[-'; - Recommended Amount V]

Increment State &

Include TRS On-Behalf Calculations:

9000 B

Expenditure Account for TRS On-Behalf

HOCRKEL4A0000C0000K
Caleulations:

Salary Change [-C - Use position hriyidly rate

For Midpoint Salaries - Increase Pay Rate to

Mimimum:

L

Include TEA Health Insurance:

[ Complete the following:

o (Recommended) In the Include Vacant Supplement Positions field, select No.

o In the Update Forecast field, select No.

o In the Update Budget field, select N - Do Not Update Budget.

o Include all first pay date codes for 11-month employees who receive their first paycheck
in August. Include all local/annual, hourly/daily, midpoint (if applicable), and extra duty
tables.

o If increases are not provided to 11-month employees in August, do not include an
increase in the salary tables. If increases are provided 11-month employees in August,
update the salary tables with the increase data.

o |If the LEA wants to interface the simulation to Budget, add the deductions with the annual
amount for the Employer Contribution.

O Click Save.

O Click Execute. Review the Simulation Process Error Listing and correct any errors prior to
continuing the process.

o Generate the simulation reports and review all salaries.

o Review the user-created report to confirm that all 11-month employees or positions are
included in the simulation. The reflected salaries are the amounts that are used to pay
employees in the current year payroll.

If necessary, continue making corrections and running the simulation until all of the salary
amounts are correct.
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O Run the final simulation. This process updates the state step, pay step, and salary amount in
the next year PMIS for all 11-month positions and clears the Accept Changes field.

o In the Update Forecast field, select Yes.

o Click Save.

o Generate and save the reports.

o Click Process to process the simulation. Create a backup.

5. (If applicable) Move employees to next year payroll.
Log on to the next year.

Position Management > Utilities > Move Forecast to NY Payroll

If your LEA uses ASCENDER Grade Reporting and/or accrues, 11-month employees may need to
be moved to next year payroll.

Execute

Select Pay Frequency:

- Semimonthly NYR

Update TRS Year Flag:

Select First Pay Date Codes or blank for ALL: [.-'-.i“--';.:‘.‘ﬂE.SI"C ] :]

Include Extra Duty:

Select Extra Duty Codes or blank for ALL: [ ] :]
Select Positions or blank for ALL:

{Includes ALL billets for selected positions [ ] :]
Blank for ALL not processed when Positions/Billets selected)

Select Positions/Billets or blank for ALL: [ ] :]
Select Supplement Positions or blank for ALL:

{Includes ALL billets for selected supplement positions [ ] :]
Blank for ALL not processed when Supplements/Billets selectad)

Select Supplement Positions/Billets or blank for ALL: [ ] :]

O Complete the following:

o In the Select Pay Frequency field, select the frequency that represents the LEA's next
year payroll.

o Select Update TRS Year Flag.

o In the Select First Pay Date Codes or blank for ALL, select the first pay date codes
that represent the 11-month employees.

o Select Include Extra Duty pay.

The additional fields can be used to move select employees and positions. V CV Click Execute.
Generate the Move Forecast Process Error Listing and correct any errors prior to continuing the
process.
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e

Processing Reports

Selact Report Mame
Mowe Forecast Process Error Listing >
U Update MYR Payroll From Forecast by Employee Mame
D Update NYR Payroll From Forecast by Campus ID

After completing any corrections, generate and save all of the processing reports.
O Click Process to process the final simulation.

Contact your regional ESC consultant if you need assistance.

6. Copy school calendars from next year to current year payroll.

Log on to the next year.

Payroll > Next Year > Copy NYR Tables to CYR > Copy Next Year Tables

COPY NEXT YEAR TABLES

e [ 1 O [ Executs H Select All Tables
Extra Duty Pay [ ] O
Hourly / Daily Salary [ ] O :
Job Code ( ] 3 :
Local Annual Salary ( ] O :
Midpaint Salary [ ] O :

@Ca.:‘.’.nz' [copcrcse ]
Stata Minimum Salary | 1 0
Substitute Salary [ ] O
Workers' Compensation Rates | | O

O In the School Calendar field, select only the 11-month employee calendars.

I I TIP: The calendar code is displayed in the first pay date code on the simulation
&  (e.g.,J40 includes calendar code 40
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O Click Execute.

Note: If changes were made to any of the next year payroll tables (extra duty pay,
hourly/daily salary, job code, local annual salary, etc.), copy the tables from the next year
payroll to the current year payroll.

7. Generate a user-created report.

Log on to the current year.
Payroll > Reports > User Created Reports

Generate a user-created report with the Hrs Per Day field selected. This field is overwritten
when positions are moved from the next year to the current year.

8. Move forecast to current year position and payroll.

Log on to the next year.
Position Management > Utilities > Move Forecast to CYR Position and Payroll

This process is used to move payroll and position forecast records to the current year PMIS with
the same information that is set up in the next year PMIS records.

It also updates fields on the following Maintenance tabs: Employment Info, Pay Info, Job Info,
Distribution

The Accept Changes field must be cleared when moving position records from forecast to
current; otherwise, position records cannot be moved. The Accept Changes field is cleared
after running a simulation with the Update Forecast field set to Yes. Similarly, you cannot run
a simulation for positions without the Accept Changes field selected.
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[ —

Select Pay Freguency:

Include Vacant Supplements

Walidste Accounts against General Ledger

U
Updats TRS Year Flag:
Update Workers' Comp Annual and Remaining Payments:
Add Additional Workers' Comp Payments: E]

Select State Minimum Salary Table (CYRMNYR):

Select First Pay Date Codes or blank for ALL:

Include Extra Duty:

Select Extra Duty Codes or blank for ALL:

Select Positions or blank for ALL:

{Includes ALL billsts for selected positions [ ] [:]
Blank for ALL not processed when Positions/Billets selected)

Select Positions/Billets or blank for ALL: [ ] [:]
Select Supplement Positions or blank for ALL:

{Includes ALL billets for selected supplement positions [ ] [:]
Blank for ALL not processed when Supolement=/Billets selected)
Select Supplement Positions/Billets or blank for ALL: [ ] :]

Clear lob Years: D

Clear lob Weekly Hours Scheduled: D

o In the Select Pay Frequency field, select the payroll frequency to be updated. LEAs with
multiple frequencies must individually process each frequency.

o Do not select Include Vacant Supplements.

o Do not select Validate Accounts against General Ledger at this time. Distribution
accounts in next year PMIS reflect the fiscal year for the upcoming school year. Finance
still reflects the current year for the fiscal year in the general ledger. When running this
process, the error report reflects funds for employees who are included in the process. It
is necessary to create the funds with the new fiscal year on the Finance > Tables >
Account Codes > Fund tab. It is NOT necessary to set up codes in the Chart of Accounts.

o Select Update TRS Year. If an employee has this field selected but they are now a 10-
month employee, the TRS Year field is cleared when the 10-month move is processed.

o Select Update Workers’ Comp Annual and Remaining Payments if the LEA
expenses worker's compensation in ASCENDER. The system references the # of months
in Contract and makes the WC Ann Pymts and WC Remaining Pymts match this
field.

o Leave the Additional Workers’ Comp Payments field blank. It is not necessary to
populate this field even if the LEA expenses workers' compensation in ASCENDER.

o In the Select a Stat Minimum Salary Table (CYR/NYR) field, select the year (current
or next ) that contains the tables with the updated amounts. If it is a legislative year and
the state minimum amounts are updated.

o In the First Pay Date Codes or blank for ALL field, select only the first pay date codes
for employees who receive their first paycheck in July.

o Select Include Extra Duty to include the supplement pay with the regular pay.

O Click Execute to execute the process. The following reports are available:

2026/01/28 17:20 10 ASCENDER - Position Management: Update NYR Positions and Move Employees to CYR Payroll


https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_moveforecasttocyrpositionandpayroll.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll

Business

Processing Reports

[ Process

Mowe Forecast Process Ermor Listing

Report Mame

Update CYR Positons From Forecast

Update CYR Payroll From Forecast by Employee Name

oooo g

Update CYR Payroll From Forecast by Campus ID

o Move Forecast Process Error Listing Important errors

[ Generste Reports ] [ Celect Al Unselect AL

Error Message

Description

Warning: The employee has
Contract Balance amounts not
equal to zero for current jobs.

The employee has not been paid off by payroll.

Failure: Position Accept
Changes Flag setto Y

The position will not be moved to the current/payroll.

Failure: Emp Nbr must have
one position declared as
primary.

The error does not necessarily reference the Primary
Job field on the position. If an employee has a regular
position and a supplement position, but there is an

error that causes the primary position to fail, this
message often indicates that there is only a
supplement position to be moved. It is recommended
to review and correct any errors that begin below this
message about primary positions. After making those
corrections, run the process again. This may resolve
the primary job errors.

This error also occurs when calendars have not been
copied to the current year.
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Error Message

Description

Warning: Emp Nbr has
multiple supplement positions
for the same job; however,
one or more of the following
do not match: Campus ID,
Dept, TRS Status Code, FTE
Units, Incr Elig, Max Paymts,
FICA Elig, Unemp Elig, EEOC,
Workers Comp, Supplement
Extra Days or Category Cd.
The values from lowest
Supplement Position
Number/Billet may be used if
new rows are inserted for the
Pay Info and Job Info tabs.

This error indicates that the fields on the Payroll >
Tables > Salaries > Extra Duty tab do not match
those selected on a supplemental position.

Use the Position Management > Inquiry > PMIS Staff
Inquiry to determine the Position Number and Billet
for any supplemental positions for the employee.
Then, use the Position Management > Maintenance >
PMIS Supplement Modify page to retrieve the position
and billet and compare the fields on the position to
the Payroll > Tables > Salary > Extra Duty tab for the
extra duty number on the supplement. For example,
in some cases the W/C code on the position may not
match the W/C code on the table. Or, the Exp 373
field on the position may be selected, but the Exp
373 on the table for that extra duty code may not be
selected. Either the table or the position needs to be
updated so that they both match. If changes are
made to the Extra Duty table, it is necessary to move
the table to the current year payroll before
proceeding.

Date Run: Move Forecast o CYR Position and Payroll Ermors
Cnity Dist: 15D Pagec 1 of 4
Paosition Mbe Billet Mbr  Pos Typ  Eror Message

Failure: Emp Mir 000007 must have one position declared as primany.
Failure: Emp Mir 000128 must have one position declared as primary.
Failure: Emp Mbr 000148 must have one position declered as primany.
Failure: Emp Mir 000200 has unprocessad Reg Hours, Ovem Hours, or Abs Ded transmittals.

Failure: Emp Mo 000200 must have one position dechred as pimary.

Eaibire Emn Mo (08 o=t bave one nosition declbred s nrimses

o Update CYR Positions From Forecast - The error report lists any funds that need to be set
up in the Finance tables.

Date Runc Update CYR Positions From Forecast
Cnity Dist: IS0 Page: 1 of 1
Position Mbr Billet Mbr  Pos Typ Description Employpes Mumber Employee Name
Mo Rows Mo Rows “acant
End of Report

o Update CYR Payroll From Forecast by Employee Name
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Date Run: Update MR Payroll From Forecast by Employee Mame
Cnity Dist: 15D Page: 1 of 1
Schoaol Year:
Emp Mbr Employes Hame
Field Oid = Field Oid MNew Field Oid Mew
No Riows Vacant Freq:
Employment D=t Campus Contract Amount
Pay S=ws Primary Job Contract Remain Amt
FICA Eligibl= Creertime Eligible Pay Rate
Unermg Eligible Incre=ss Eligible Hriy/Diy Rate
TRS Status Calendar Code Crzrtmz Rate
Job Code St Sep Dock Rate
Pay Concept TRS Year Saate Min Szlary
Fay Type TRS Position Code Mbr Mon Contr
Contract Begin Dste Accrzl Code Mbr Annl Pymis
Contract End Dzte Ex=mpt Status Mbr Rem Pymts
Fayoff Cate hbr Days Contract Job Pt Az=gnd
Fay Grads hbr Days Empld Pict D=y Empld
Fay S=o Mz Cay= Hrs Per Day
Sched Wik's Comp Annl Mbr Diays OF
EEOC Code ‘Wrk's Comp Remain

o Update CYR Payroll From Forecast by Campus ID

Wrk's Comp Remain

Date Run: Update NYR Payroll From Forecast by Campus ID
Cnty Dist: 15D Page: 1 of 1
School Year:
Emp Mbr Employes Name
Field Oid = Field Oid Mew Field Oid Mew
Mo Rows Vacant Freqr
Employment Dats Campus Confract Amount
Fay Sw=tus Primary Joo Consract Remain Amit
FICA Eligible Crezstirme Eligible Pay Rate
Unemg Eligible Incre igible Hriy/Déy Rate
TRS Status Calendsr Code Iwertmz Fate
Job Code SiEte Swep Dock Rats
Pay Concept TRS Year Sazte Min Sslary
Pay Type TRS Position Code Nbr Mon Contr
Coniract Begin Cate Accrual Code Nbr Annl Pymts
Contract End Date Exemipt Status Mbr Rem Pymts
Fayoff Cate Wbr Days Contract Job Pt A==gnd
Fay Grads Mbr Days Empld Pt Day Empld
Pay B=c Max Day= Hrs Per Day
Wrk's Comp Annl Mbr Days Off

U Click Generate Reports. The selected reports are displayed. Review the report.

O Click Continue to view the next report. Or, click Return to return to the report selection

page.

O After reviewing all of the reports and correcting all errors, return to the report selection
page and click Process to move the forecast records to the current year. You are prompted

to create a backup.

After the process is completed, the actual update is performed. If the update is
successful, a message is displayed indicating that the move forecast updates were

successfully processed.

O Click Cancel to return to the Move Forecast to CYR Position and Payroll page without
moving the forecast records to the current year.
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If corrections are processed, repeat this step.

Generate and save each report. Compare the Update CYR Positions From Forecast report to
the user-created report that was previously generated to confirm that all 12-month
employees are included. The last two reports contain the same information; one is sorted by
employee name and the other by campus ID. These reports reflect the existing salary in the
current year payroll and the new salary, which overwrites the current year payroll amounts.
Review the reports for accuracy.

9. Confirm that the CYR salaries are accurate.

Log on to the current year.

Verify the current year data to confirm that the salaries are correct. The highlighted fields are
updated:

W Meintmnsncs = SEt kobyPay Dits ~ Payroll 5§

0 O DESTRIERTIONS DEDUCTIONS. LEAWT BALANCE
) ' reg Car
( 3 s LS l 2
i : = remployment Eby- [7] 2 MulsiJob (]
- .-.l‘_-.:.. J.,.: .....l i ..I.f. Lo > i wnchr 17 [__j
. v M _.... P e T PE— |:|
0100
T

Detets  Extra Doty P Cods T Ancunt Pemais Ami  Pumain Permts
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%  Maintanance > Staf Jcb/Pay Dats ~ Payroll 55

[PY INFO Ka

] CHSTREBUTIONS. DEDUCTIONS LEAVE BALAMCE

Delete  Selected  [ob Code Primgry 3§ Asgigrid Py Type

8 D 1158 - TECHNDLOGY TECHNICIANS i @ ittt

40T CONATRCHEd M

Ealance

El SLIGE Fehn Uiyt ]:_:.:,—_;_ [Irr—— W] BEEATRED JETe— e
oty Tisead: 2 of Dy Erplal
Contract Total ® Anveal Bymis

By [ OVMMRm () R 000

State Stap CI ¥rs in Canser Lacid [E "". L A RS Mamber Pos il Sap At oo
Seate Min Salary I—l Ferursiation Daily Rate W A d & of daryt Er
Cabendurloc info
Calendarfocal Opgons:

Years bob Exp ﬂ Lecal Contract Days: B-

Wirkery” Comg nfg

(- Code i B80S PRONADELADME Q001N v | T Ann Py [_.] W B g m)

Aczrusl mdo

Cipie I:I! cerual Rate ,. - Tows B ol Dwgn B

M Maintenance > Staff Job/Pay Data ~ Payroll 53
[ s ]

Employes: [ |

PAY INFO OB INFO DISTRIBUTIONS DEDUCTIONS LEAVE BALANCE

Delete Details  Job Code Extra Duty Account Type

Account Code Amount Percent
] o 1158 - TECHNOUOGY TECHNICIANS G 155-53-0125.00-535-259000 2530600 100.000%
Total 2830600 100.000%
Rows: 1of 1  Refrgsh Totals v}
soo fooe [ 1158 - TECHNOLOGY TECHMNICL W |
Extra Duty Code: [ w | Activity Code [£0 Base Salary w | l " .
Account Type: G Standard gross pay v] TRS Grant Code
Acoount Codw: (199-53-6129.00-395-299000 J Warker's Comp Code:  BE5S-PROFAIDES/ADMS.
geription
Daezcription; Expense 373 1‘. Account not used in ASE distr WV il
Amount 28.306.00 | out of 28.306.00 Ernployer Contribution IE[
ot 100.000% Performancs Pry D

2026/01/28 17:20 15 ASCENDER - Position Management: Update NYR Positions and Move Employees to CYR Payroll


https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_jobinfo.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_distributions.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll

Business

10. Mass update fiscal year.

Log on to the current year.

Payroll > Utilities > Mass Update > Employee

Skip this step if your LEA has a 7/1 fiscal year.

Mass update the fiscal year to the next school year for all employees.

Select Fiscal Year and type the next year fiscal year. Before processing, stop to consider if the
LEA uses other fiscal years in the account codes for employees. If the entered year is not the
only used fiscal year, additional parameters may need to be selected.

Contact your regional ESC consultant if you need assistance.

Mass update the current year Wkly Hrs Sched and Hrs Per Day fields.

o Select Wkly Hrs Sched and type the number of hours displayed for the majority of
employees. Any exceptions can be manually updated in the current year payroll.
Reference the previously generated user-created report.

o For LEAs that use the hours per day functionality in the current year payroll, select the
Hrs Per Day field and type the number of hours per day for the majority of employees.

o Use the parameters to select specific groups of employees for the update.

11. Generate the HRS6000 Account Code Comparison Report.

Payroll > Reports > Payroll Information Reports > HRS6000 - Account Code Comparison

This report compares the account code on the employee’s master distribution record and
compares it to the Chart of Accounts in Finance file ID C.

O Complete the following parameters:

[ Freview l [ FDF ] | | [ Clear Options ]

Payroll Information Reports HRSE&000 - Account Code Comparison
HRS1250 - Employes Data Listing %
Salary Information

E ey Parameter Description Walus
E000 - Account Code Comparison /r_
- Contract Balance Variance Report 2 R
HRS6150 - Employee Payroll Listing Port by Mot AL ¥ Comenss 1 P Camens: i

HRSE400 - Salary Verification Repart
HRSE450 - Health Insurance Coverage
HRSE650 - CYR/MYR Salary Comparison From Date (MMDDYYYY)

Include Reports (Select From List)

To Date (MMDDYYYY)

\I\"i_s:atus Active [A), Inactive (1), or blank for ALL ! A
Pay Type 1-4, or blank for ALL
Select Pay Campusies), or blank for ALL :] H
Select Primary Campaus(es), or blank for ALL [:] :
Select Employee(s). or blank for ALL :] H
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If the LEA has multiple pay frequencies, generate the report for each frequency. The generated
report should be blank. If any account codes are listed, determine if the account codes need to
be added to the Chart of Accounts in Finance or if the employee distribution record needs to be
modified.

12. Generate the HRS6050 Contract Balance Variance Report.

Payroll > Reports > Payroll Information Reports > HRS6050 - Contract Balance Variance Report

This report looks at the pay rate for each employee and multiplies it by the number of
remaining payments, and compares that amount to the Contract Balance on the Job Info tab. If

there is a variance of more than a few pennies, perform manual calculations to determine if any
corrections are needed.

Generate the report for pay type 1 and again for pay type 2.

O Complete the following parameters:

Payroll Information Reports
HRS1250 -

Employes Data Listing

HRS1650 -
HRSE000 -

Employee Salary Information
Account Code Comparison

HRSE050 -

Contract Balance Variance Report

HR56150 -
HRSE400 -

Employes Payroll Listing
Salary Warification Report

HRSE450 -

Health Inswrance Coverage

HRS6650 -

CYRINYR Salary Comparison

HRS&050 - Contract Balance Variance Report

Parameter Description

Value

¢ Sortoy Alpha (3, Pay Campus (C). Prmary Campus ()

Maximum Acceptable Difference
\Eﬂ'_s:atua Active (A), Inactive ([, or blank for ALL A
—
Pay Type 1-4, or blank for ALL
Select Pay Campusies). or blank for ALL :} H
Select Primary Campusfes), or blank for ALL :} H
Select Employeeis), or blank for ALL :} H

13. Enter new hire data.

[Date Run: Contract Balance Variance Report Program: HRSE050

Cnty Dist: 15D Page: 1.af 4

Variance Threshold:  0.10 Froquancy: E
Emp Nbr Employoe Name Job Cd Pay Rate Remain Pymits Computed Bal Actual Bal Varlanca
000018 AGUILAR, AIDA 1602 11,32 24 271,68 16,478.00  16,206.32
000148  AHOURLY JR, OMLY M 1504 14.38 24 34512 2991000 29554 88
000831 AHOURLY, REGULAR 1504 10.24 24 245.7T6 21,299.00 21,053.24
000DE0  AYALA, ANA M 1154 1,150.38 24 27.609.12 27.609.00 =12
0000B0 BEASLEY, ANTONIO 1602 11.82 24 286.08 1582400 1553792
000085 BERRELEZ, BARBARA L 1353 B93.88 24 21,453.12 21,453.00 =12
000097 BERRELEZ, BELINDA ROSARIO 1602 B8.35 24 2.120.40 1652200  14.401.60
000102 BISHOP. BENITA IRENE 1455 B20.38 24 19.689.12 19,689.00 =12
000148 CANTU. CARMEN 1702 15.68 24 37584 2254500 2216918
000167 CARRIZALES. CHERYL K 1505 13.82 24 331.68 28,746.00 2841432
000187 CASTRO-VELA, CONCEPCION C 1309 2,135.38 24 51,249.12 51,249.00 =12
000193 CERVANTES, CONSUELO 1502 15.93 24 3s2az 3313400 3275168

| OO0 CORREA DAMIFIL 1508 13 44 24 321 R4 27 ROR 00 T 5T 1R
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Log on to the current year.

Use the Staff Job/Pay Data pages to enter new hire data. The HRS1550 - New Hire Report is
helpful to identify these employees.

When new hires are entered in the next year Position Management and moved to the current
year payroll, only the fields related to the position are populated.

Manually update the following:
Personnel > Maintenance > Employment Info

o Employee Status

Highest Degree

Percent Day Employed

Original Employment Date or Latest Re-Employment Date
o Retirement Date (if applicable)

o Years of Experience

o Employment Type

[¢]

[¢]

[¢]

Payroll > Maintenance > Staff Job/Pay Data > Pay Info

o Pay Campus

FICA Eligibility
W-4 Marital Status
Nbr of Exemptions
Bank Information

[¢]

o

[¢]

[¢]

Complete the Payroll > Maintenance > Staff Job/Pay Data > Deductions tab.

Payroll > Maintenance > Staff Job/Pay Data > Leave Balance - This tab can be updated in
September using the First Pay Date of the School Year instructions.

14. Run payroll calculations.
Log on to the current year.
Payroll > Payroll Processing > Run Payroll

Run payroll calculations to verify any errors.

10-month Employees
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